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1.0 Why we check pointing and SEFDs before each experiment 

An initial check of pointing serves to verify that several aspects of the system are working 

correctly. 

 

1.1 Verify signal is getting from the front-end to the back-end 

 

The very act of checking the pointing and SEFDs using the detectors in the DAR 

verifies that signal is getting to the back-end. Each channel should yield the 

expected sensitivity and beamwidth. See also 1.5. 

 

1.2 Verify sensitivity 

 

The SEFD is a very useful measure of the antenna’s sensitivity. Verifying that you 

get the expected sensitivity demonstrates that many parts of the system have not 

failed since the last more thorough check. 

 

1.3 Verify pointing is good 

 

Verifying that the pointing is good demonstrates that there has been no serious 

degradation in the antenna’s pointing accuracy since it was last checked. 

 

1.4 Verify system time and date 

 

Depending on the details of the antenna interface, checking the pointing verifies 

that the date and time in either the FS computer or the pointing computer or both 

are correct at some level. If both, i.e., the FS and pointing computer have 

independent times, you should verify each independently, and compare them to 

each other. An error of one day will cause an approximately 1° pointing error. An 

error of a few seconds may not be detected, unless the beam is small enough. 

 

1.5 Verify IFs aren’t switched (many stations don’t need this) 

 

If you switch IFs depending on the experiment, verifying the beamwidths and 

SEFDs of each IF is good check that they are connected to the correct channels. 
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1.6 Things that can’t be checked by pointing and SEFDs 

 

These are some of the items that aren’t verified easily by checking the pointing and 

SEFDs. They require some other means of verification that will typically be 

different at different stations. 

 

1.6.1 Polarization 

 

The sensitivity of the antenna may not be very different for different 

polarizations. 

 

1.6.2 Sub-band  

 

If you have more than one IF for a given band it may be difficult to 

distinguish between them based on the measured beamwidth. 

 

1.6.3 Time errors below the level detectable by the beam 

 

Unless the beam is small you may not be able to detect errors on the order 

of one second in time, much less a fraction of a second. 

2.0 Set-up 
 

There are several steps that are needed to set-up pointing checks in the FS. They need to 

be done only once. After that, the steps in the following sections can be expected to work. 

Please see the ACP User Guide manual, Section 5, in Vol.2 of the FS Manuals for more 

information on installing the system. 

 

2.1 antcn must support modes 0-5 (plus 8 for non-standard detectors) 

 

antcn provides the basic interface between the FS and the antenna. The listed 

modes must be supported for the fivpt and onoff programs to work. Please 

refer to the FS Manuals Vol. 2, Station Programs manual or the TOW seminar 

“Topics in FS Coding” for more information on implementing antcn. 

 

2.2  Set-up the .rxg files. 

 

The .rxg files contain the gain calibration information for each band. It contains: 

LO values (or range if tunable), polarizations available, FWHM, the gain curve, 

gain values (DPFU) for each polarization, and Tcal values as a function of 

frequency for each polarization. The set-up of these files is described in the default 

files in /usr2/fs/st.default/control/rxg_files (x.rxg and 

s.rxg). Don’t change the versions in the /usr2/fs source tree (the FS doesn’t 

use those copies). Instead, copy/rename the default files to the 

/usr2/control/rxg_files directory giving them names (the part before the 
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.rxg) that are mnemonic for the band or receiver, and edit them there. There are 

no fixed values for the names, but they must be unique within the directory. The FS 

will read in all files with the extension .rxg, up to 20 of them. The comments in 

the default files should be self explanatory, but here are a few hints about how to 

set-up the files. The lines you should probably edit are: 

 

(1) The LO values, this must match the values used in the LO=... command for 

the RX you will be using.  PLEASE NOTE: you should not put information for 

a given LO value (even within a range) in more than one file, i.e., any given LO 

value should not be covered by more than one .rxg file. 

 

(2) Creation date. 

 

(3) The FWHM of the beam. 

 

(4) The polarizations available: lcp and/or rcp (currently for horizontal and 

vertical use lcp and rcp respective, they can be related by the mnemonic that 

both are in alphabetical order: “l” then “r”, “h” then “v”). 

 

(5) The DPFU(s). If you don’t know them, they can be estimated as the Tsys in 

Kelvin divided by the SEFD. 

 

(6) Gain curve. If you have a gain curve in the form of ELEV POLY or 

ALTAZ POLY, you can enter the coefficients on the appropriate line, zeroth 

order term first, if you have no gain curve leave the value as 1.0. 

 

(7 and the following lines up to end_tcal_table line) Tcal versus frequency 

table. If you have this information, currently there can be up to 1200 total lines 

(as of FS 9.13.0), if you don’t have this information you can enter a single value 

for each polarization in the band and the FS will use that for all frequencies. 

 

(the line after the end_tcal_table line) Receiver noise temperatures. Values 

of zero will do for an initial guess. 

 

(the remaining lines up to the end_spillover_table line) A spillover table. 

Currently up to 20 lines, a spillover table is not needed initially but can be 

entered if available. 

 
2.3 Customize ctlpo.ctl 

 

This control file specifies the sources that aquir will attempt to observe and what 

actions it will take for each. Typically, the only changes needed are to decide which 

sources are suitable for pointing and SEFD measurements at the band being used. 

Sources can be repeated for additional/different measurements on them. Unused 

sources can be commented out. You can of course have multiple version of this file 
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for different bands and applications. Different versions of this file might also refer 

to different versions, if needed, of the initp procedure in the point procedure 

library. 

 

2.4 Customize point.prc 

 

This procedure library contains the pointing specific SNAP procedures that are 

needed by the aquir program and/or are otherwise general useful for pointing 

checks, especially with a dual S/X receiver. You can of course have multiple 

version of this file for different bands and applications. Another alternative is to 

have differently named procedures for different bands and applications. 

 

2.4.1 The initp procedure should completely set-up system. 

 

This procedure is used to initialize the system before doing any pointing or 

SEFD. It should fully set-up any equipment that is needed, including any 

station specific equipment. It should also do any necessary software set-up 

such as the parameters to sue for the fivept and onoff commands. You 

can have different version for different bands and/or different purposes, e.g., 

pointing versus gain calibration, 

 

2.4.2 The acquire procedure to initiate acquisition 

 

This procedure can set the log to convenient name for the purpose of the 

acquisition (the default is point) and run the aquir program with the 

appropriate version of ctlpo.ctl. The aquir program accepts a single 

argument, which is the name of the source (as stored in the control file) to 

start measurements with, if it is up. If no source is specified it starts with 

the first one that is up. 

 

2.4.3 The prep procedure 

 

This procedure is used to do any per source initialization. This can include 

setting initial offsets, if the current model is too far, adjusting gain, and 

sampling meteorological data, as well as other actions. You can specify 

different versions on each source. This also might be useful to select 

different BBC frequencies for the measurements for multiple instances of 

the same source to cover more frequency range more densely. 

 

2.5 Customize parpo.ctl 

 

This file is used to control the editing of pointing data during the initial extraction 

of the data from the log. Generally, you should just enter your antenna name and 

its axis type and turn off the editing features which as mostly obsolete. It is 

recommended that the hex control flag on line 3 have the value 3. 
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2.6 Customize mdlpo.ctl 

 

This file contains the standard FS pointing model. It is used by the pointing data 

analysis programs. If your antcn uses it also to calculate pointing corrections, the 

results of a pointing analysis are directly available to correct the pointing of your 

antenna. The angle of the fixed axis relative the ground, φ (phi) must be entered in 

degrees: AZ/EL uses 90, X/Y antennas 0 and HA/DC antennas use the geodetic 

latitude. Normally, the first eight parameters are turned on initially. However, it is 

recommended that the second parameter be turned off if φ is 90, i.e., usually for 

AZ/EL antennas. Additionally, parameters may be needed if there are other 

unmodeled systematics in the results when they are analyzed. Normally, the 

parameter values are initially zero. 

 

2.7 flux.ctl 
 

This file contains the source flux models. It should not need to be customized 

unless there are sources that you use that aren’t included. If so, please send them 

to Ed (Ed.Himwich@nasa.gov) to be added to the default version. 

 
2.8  What if you have a non-standard detector 

 

If you have a non-standard detector, e.g., a power meter, you can support it using 

mode 8 of antcn. Two non-standard detectors, u5 and u6 are supported. The 

implementation assumes you have some way to remove the signal from the 

detectors under computer control, e.g., by switching a large value of attenuation 

into the signal path. This is done by the standard procedure sigoff. The normal 

attenuation is restored by the standard sigon procedure. These procedures are 

also discussed in the help pages for fivept and onoff. Please see the file 

/usr2/fs/misc/stndet.txt for details on how to implement the detector 

in antcn mode 8. Please note that the “Use” section in the version of this 

document from before FS version 9.9.3 is out of date. If you don’t have FS 9.9.3 

or later, you can obtain a more up to date version of the file from Ed 

(Ed.Himwich@nasa.gov). Please see the help file for the user_device SNAP 

command for how to define the parameters for the user devices. As of FS 9.13.1, 

you can disable the use of sigon and sigoff if the zero level of your detector 

is close enough to zero; this is often the case for digital detectors. 

 

2.9 What if you have no cal diode 

 

If you have no noise diode, set the diode noise temperatures in the relevant .rxg 

file to a negative value. The absolute value of the specified noise temperatures will 

be assumed by the pointing programs to be the system temperature. The antenna 

temperature due to the source will be calculated on this assumption. However, the 

SEFDs will be unaffected. A value of -100 is convenient. The result will be that 



Automated Pointing Models Using the FS 

 6 

antenna temperatures will come out in percent of the system temperature (which 

may vary, for example with elevation).  

3.0 Manual checks 
 

This section describes how to perform manual checks once the system has been set-up as 

described in the previous section. This is described in more detail in ACP User Guide 

manual, Section 3, in Vol.2 of the FS Manuals. Start the FS and enter the following 

commands in order: 

 

3.1 proc=point 

 

This command selects the point.prc SNAP library. If you are using a pointing 

library with a different name, such as vpoint.prc, enter that library’s name 

instead 

 

3.2 initp 

 

This command runs the initp procedure, which should have been customized 

already to set-up your equipment for pointing checks. 

 

3.3 (source procedure) 

 

Here you enter the name of the source that you want to use to check pointing. The 

procedure library point.prc has procedures with coordinates for most of the 

useful Northern Hemisphere pointing sources. To see which are available, use the 

ds command in pfmed, when point is the selected library. The flux models for 

the sources that are good calibrators are include in the flux.ctl file. 

 

3.4 prep 

 

This command runs the pre-source initialization, which may be needed for example 

to adjust the gain. 

 

3.5 fivept 

 

This command runs the fivpt program to peak on a source. It does this by 

measuring the power level on two slices through the source. Normally you would 

wait for the source to be acquired before typing this command, but if the antenna 

isn't onsource and aquir isn’t running, fivpt will wait for up to one minute for 

onsource to be achieved before giving up. When fivpt finishes normally it logs 

an offset record. If some very nominal checks of whether this was a good peak 

are passed, the offset record will have two ones (1 1) at the end signifying 

success. The first four parameters in the offset record are: (1) first axis 

coordinate, (2) second axis coordinate, (3) first axis offset, and (4) second axis 
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offset. The xoffset record contains similar information, but reports the first axis 

offset corrected for cosine of the second axis coordinate (the so-called “cross” 

offset) and the sigmas of the offsets (first axis sigma also corrected for the 

elevation). The values in the xoffset record are generally more useful than the 

offset record for a quick determination of whether the pointing is good and 

include the detector and source names to facilitate selection with grep. 

 

3.6 onoff 

 

This command runs the onoff program to measure SEFDs and other antenna 

performance parameters. If you execute it immediately after fivpt has finished, 

leaving in the offsets that fivpt found, you will get a “peak” performance 

measurement. 

 

3.7  (next source procedure) 

 

If you wish to make another measurement, select a new source. If the fivpt 

program for some reason returned unrealistic offsets, you may want to remove them 

before trying to peak on the next source. Continue using prep, fivept, and 

onoff for each additional source as desired. See the sectioned “3.8 When 

finished” (below) for how to remove the offsets. 

 

3.8 When finished 

 

If you do not want the most recent fivpt offsets to remain in use (typically for 

geodesy observing you don’t), use xyoff=0d,0d, azeloff=0d,0d, or 

radecoff=0s,0d (or whatever offsets are desired) depending on the axis system 

of your antenna. 

 

4.0 What fivpt does 
 

This section briefly describes what fivpt does. 

 

4.1 Measure Tsys off source to calibrate scale 

 

This is the first step. It uses the noise diode to measure the system temperature off 

source. If there is no noise diode, indicated by noise diode temperature less than 

zero, then the negative of the specified diode temperature is assumed to be the 

temperature of the system off source in order to calculate the necessary conversion 

factors. 
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4.2 Scan both axes 

 

The source is scanned on two axes, nominally aligned with the telescopes natural 

coordinates. Typically, nine measurements, 0.4 FWHM beamwidths apart, are 

taken. 

 

The data are displayed in the lat and lon records. These correspond respectively 

to the latitude-like and longitude-like coordinates of the antenna: EL/AZ, Y/X, and 

DEC/HA, respectively. The data in each record are: (1) the number of the point, (2) 

the seconds since the midnight previous to the scan (which grows monotonically 

even if a scan spans another midnight), (3) the offset on the scanned axis, (4) the 

antenna temperature due to the source (above the measure system temperature, may 

be negative due to changes in ground pick-up and RFI), and (5) if the integration 

period is larger than one, the RMS scatter of the samples. 

 

4.3 Fit Gaussian + offset + slope 

 

The data for each axis are fit to a five-parameter function consisting of a Gaussian 

(three parameters: peak offset, half-power beamwidth, and peak temperature) plus 

an offset and slope (in time). If the fit is nominally successful, the last parameter 

on the XXXfit (XXX is lat or lon) line is positive. The estimated errors in the 

parameters are displayed in the associated XXXerr line; the last value of which is 

the RMS fit of the model to the data. 

 

4.4 Repeat if not well centered or a fit failed 

 

For a typical set-up, if the peak for either axis is off by more than a half 

measurement step (this is perhaps too tight) or if the fit on either axis failed, the 

measurement will be repeated a second time. This assures that the source is roughly 

centered in the data set, which may also be helpful in the case of a weak source. 

For weak sources, if the beam is not well centered on the second axis scanned, the 

first axis scanned may not have enough signal from the source to find a clear peak. 

 

4.5 Leave the telescope “peaked” on source 

 

After the final scan, the offsets of the fitted peak are left in use. This is useful if you 

plan to run onoff next to find the “peak” performance. However, be careful after 

doing pointing checks to remove the last offsets before acquiring VLBI data, unless 

the source is strong and you will be acquiring data on that source in that part of the 

sky only (this is not usually the case for geodesy). 

  



Automated Pointing Models Using the FS 

 9 

4.6 Sample fivpt output 

 

The following is an example fivpt output. The format of the time/date stamp in 

the log is an old form no longer in use now, but the actual entries are current. 

 
9735612401440#fivpt#source cas-a      232109.0 +583230 1950.0 97/356.12:40:14  
9735612401445#fivpt#site GILCREEK 147.4976  64.9784   0.00 xxxx   0  1.00  0.00  
9735612401445#fivpt#fivept xyns  -2  9 0.40  1 3u  19.0  0.0834     399.1  
9735612401451#fivpt#origin   0.0000   0.0000   0.0000   0.0000   0.0000   0.0000  
9735612402363;calofffp 
9735612402806;calonfp 
9735612403043;calofffp 
9735612403066#fivpt#tsys 336.447  36.913  61.922  
9735612404069#fivpt#lat   1  45640.  -0.1334    1.158  
9735612404894#fivpt#lat   2  45648.  -0.1001    2.183  
9735612405769#fivpt#lat   3  45657.  -0.0667   11.597  
9735612410669#fivpt#lat   4  45666.  -0.0334   29.098  
9735612411569#fivpt#lat   5  45675.   0.0000   38.361  
9735612412469#fivpt#lat   6  45684.   0.0334   28.832  
9735612413369#fivpt#lat   7  45693.   0.0667   11.370  
9735612414269#fivpt#lat   8  45702.   0.1001    2.556  
9735612415094#fivpt#lat   9  45710.   0.1334    1.227  
9735612415095#fivpt#latfit  -0.00032  0.0994 38.3030  0.5406  0.0035   4  
9735612415095#fivpt#laterr   0.00070  0.0020  0.5503  0.3844  0.0098   0.5838  
9735612415968#fivpt#lon   1  45719.  -0.1971    1.177  
9735612420869#fivpt#lon   2  45728.  -0.1479    3.239  
9735612421694#fivpt#lon   3  45736.  -0.0986   12.508  
9735612422569#fivpt#lon   4  45745.  -0.0493   29.294  
9735612423394#fivpt#lon   5  45753.   0.0000   39.025  
9735612424269#fivpt#lon   6  45762.   0.0493   30.376  
9735612425169#fivpt#lon   7  45771.   0.0986   12.768  
9735612425994#fivpt#lon   8  45779.   0.1479    2.594  
9735612430869#fivpt#lon   9  45788.   0.1971    1.531  
9735612430870#fivpt#lonfit   0.00110  0.1024 38.7746  0.6563 -0.0033   5  
9735612430870#fivpt#lonerr   0.00111  0.0022  0.5846  0.4250  0.0108   0.6198  
9735612430870#fivpt#perform    2.041   637.4    0.509    8.223  
9735612431562#fivpt#offset   332.6681   47.5413   0.00110  -0.00032  1  1 
9735612431562#fivpt#xoffset  332.6681   47.5413   0.00074  -0.00032  0.00075  0.00070 1 1 cas-a 

 

(The xoffset record in this example was manufactured by hand for illustration 

purposes. This was necessary because the example shown data was collected before 

this feature existed.) 
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5.0 What onoff does 

 

The onoff program is a simple tool for measuring the SEFDs of the antenna in multiple 

detector channels simultaneously. 

 

The following measurements are made, typically with two iterations for everything except 

the no signal case, which is only collected in the first iteration the actual displayed log 

record labels shown in square brackets ([…]): 

 

5.1.1 Power on source [ONSO] 

5.1.2 Power on source with noise diode on [ONSC] 

5.1.3 Power off source with noise diode on [OFFC] 

5.1.4 Power off source with noise diode off [OFFS] 

5.1.5 Power off source with no signal for “zero” level [ZERO] 

 

A final set of power onsource and onsource with noise diode on are included to make the 

on and off source measurement procedure symmetric in time. 

 

5.2 Final results are displayed on one like for each detector: Gain Compression, 

Tsys, SEFD, Tcal(j) in Janskys, Tcal(r) ratio. For interpretation of the last two 

items, please see the notes for the TOW Antenna Gain Calibration and Pointing 
and Single Dish Amplitude Calibration classes. 

 

The results are printed in several forms to facilitate analysis depending on what is 

needed. You need to be careful of Tsys and Tcal(r) ratio values which depend on 

the accuracy of the a priori noise diode values. The Compression, SEFD, and 

Tcal(j) in Janskys do not depend on the a priori noise diode values. 

 

5.3 Sample final results from onoff output 

 

2002.310.20:49:31.27#onoff#    source       Az   El  De I P   Center   Comp   Tsys  SEFD  Tcal(j) Tcal(r) 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 1u 1 l   4969.99 0.2658 18.34  438.0 487.272 2.8850 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 2u 2 r   4969.99 0.2548 16.83  421.3 480.612 3.0234 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 3u 1 l   4977.99 0.2869 17.70  435.2 501.462 2.9690 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 4u 2 r   4977.99 0.2673 16.78  425.8 487.400 3.0661 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 5u 1 l   4985.99 0.3214 17.25  445.8 527.168 3.1212 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 6u 2 r   4985.99 0.3032 15.81  422.6 513.282 3.2289 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 7u 1 l   4993.99 0.3533 16.68  452.2 553.065 3.2745 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 8u 2 r   4993.99 0.3353 15.39  431.3 537.976 3.3842 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 9u 1 l   5001.99 0.3684 16.45  455.1 564.312 3.3411 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 au 2 r   5001.99 0.3464 15.14  430.8 546.332 3.4368 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 bu 1 l   5009.99 0.3959 15.67  454.0 591.040 3.4993 
2002.310.20:49:31.30#onoff#VAL cygnusa    273.4 52.0 cu 2 r   5009.99 0.3710 14.79  437.0 567.122 3.5676 
2002.310.20:49:31.30#onoff#VAL cygnusa    273.4 52.0 du 1 l   5017.99 0.4232 15.43  468.8 619.723 3.6691 
2002.310.20:49:31.30#onoff#VAL cygnusa    273.4 52.0 eu 2 r   5017.99 0.3912 14.57  444.4 585.618 3.6839 
2002.310.20:49:31.30#onoff#    source       Az   El  De I P   Center   Comp   Tsys  SEFD  Tcal(j) Tcal(r) 

6.0 Automated measurements 
 

This section describes what is needed for automated measurements. Once set-up, this is 

even easier than doing manual measurements. Start the FS and enter the following 

commands in order: 
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6.1 proc=point 

 

This command selects the point.prc SNAP library. If you are using a pointing 

library with a different name, such as vpoint.prc, enter that library’s name 

instead. 

 

6.2 acquire 

 

This procedure starts the aquir program running. Typically, aquir uses the 

ctlpo.ctl control file and the log is changed to point.log. However, you 

can have other procedures that start acquisition and that use other control files. For 

example, you could make a version that uses only the very strongest sources for a 

quick pointing check and returns the offsets to zero when stopped. Once started, 

aquir runs indefinitely until it is kill’ed. Typically, you use 

acquire=source to start with a specific source. 

 

6.3 To stop: kill 

 

The kill procedure will stop any of fivpt, onoff, and aquir that happen to 

be running. Typically, it also changes the log back to station.log. Using kill 

does not normally change the offsets back to zero. Follow the procedure under “3.7 
When Finished” in the “3.0 Manual Checks” section above, to do that. 

7.0 Pointing Data Analysis: pdplt 
 

This section describes the use of the pdplt program to analyze pointing data to determine 

a pointing model. The pdplt program is a Tcl/Tk application that provides a graphical 

front-end for the text based pointing data analysis programs. It is run by typing pdplt to 

a shell prompt. A brief sketch of some of its capabilities follows. More information can be 

found in the pdplt documentation available on the FS servers.  

 

7.1 Selecting a New input file 

 

To select the input file, click on the File main menu entry and then select New. 

This will display a Tk file selection dialogue box open to /usr2/log. You can 

either type the name of the file, including its extension, such as .log or navigate 

using the dialogue box and double click on the file you want. You can load a FS 

log file even while pointing data is being written to it for a check of the results “so-

far”. 

 

Please note the model file (usually mdlpo.ctl) in pdplt must be the same as 

the one used to collect the data; this is usually the case for this input option. You 

can change the used model file by changing the Control file for error 

under I/O Setup on the File menu. 
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7.2 Selecting an existing input file 

 

Click on the File main menu entry. There is an Open option that can be used to 

open an existing xtrac output file such as was saved by the Save option on this 

menu.  

 

Please note when choosing this option, you must use the same model file (usually 

mdlpo.ctl) in pdplt as was used when the data was collected; this will 

typically NOT be the case for this input option. Please see section 7.13 for how to 

change the used model file in pdplt if that is needed. 

 

7.3 Examining sky coverage 

 

The first plot that is shown is sky coverage. This is done in the natural coordinates 

of your antenna assuming that the parpo.ctl control file has been set-up 

correctly. You can select which graph to look at using the Graph menu to select 

which graph to examine. The letters n and p can be typed to move the next and 

previous graphs respectively (with wrap around at the ends). See the attached plot 

of sky coverage for a pointing data set from Tsukuba. Ideally, the entire sky should 

be covered more or less uniformly. In this case, the sky coverage in this case is 

remarkably good due to Tsukuba being a very sensitive antenna at a mid-Northern 

latitude location. 

  

7.4 Points on the plots 

 

Points that are included in the solution are shown as solid circles. Points that are 

deleted are show as open circles. Information on individual points is displayed 

when the pointer comes over or near it. On the residual plots all included points are 

shown by default on the interior of the plots when they have been auto-scaled. Any 

points that lie outside the range of the plots are shown on the edge. Points are 

normally shown with one-sigma a priori error bars (see section 7.10 for control of 

how the error bars are displayed). 

 

7.5 Residuals, random versus outliers and non-random  

 

Ideally the residuals of the pointing solution should appear to be a random scatter 

about zero offset with a Gaussian distribution for both offsets types against both 

axes (four plots). Two major reasons they might not be are: (1) so-called “blunder” 

points, which are just points that lie a lot farther from zero than other points in the 

vicinity, due for example, to some failure of fivpt, and (2) systematic trends in 

the data, such as slope, curve, or sinusoid pattern in the residuals. To correct the 

former problem, you can remove a point by editing it out of the data, see “Editing 

Data” below. The latter problem usually has to be dealt with by changing the model, 

see “Changing the Model Parameters” below.  
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By default, the residuals to the fit as shown on the plots. There is one attached plot 

that shows the raw points for Elevation offsets versus azimuth (see section “7.7 

Viewing the raw data”) for a data set collected at Tsukuba. Even though these are 

raw data, except for one thing they would look almost as random as an acceptable 

set of residuals. The exception is that there is a roughly sinusoidal variation in the 

offsets as function of azimuth. Another attached plot shows the post-fit residuals 

for the same data. In this case, there is no visible systematic; an updated pointing 

model absorbed this effect. (You can tell the two plots apart by the presence or 

absence of this sinusoidal variation and the added legend at the top.) This is an 

example of how the fitting process can remove systematic variations from the raw 

data. The resulting model will point the antenna more accurately than it pointed 

before the new model. 

 

Another default behavior of pdplt is that the offsets for the first (the longitude-

like) coordinate (Az, X, or H.A.) are displayed as “cross” offsets, which means they 

are multiplied by the cosine of the second (the latitude-like) coordinate.  This has 

the effect of normalizing the scatter of points far from the zero point of the second 

coordinate due to the compression of the first coordinate near the poles of the 

second. The “cross” offsets are labeled as xEL, xY, and xDC on the plots.  This 

behavior can be turned off, i.e., to display the first coordinate offsets in unmodified 

form, by adjusting the flag in the third line of the parpo.ctl control file. This 

flag can also be used to independently change the use of “cross” coordinate formal 

error constants to non-cross formal error constants. The formal error constants are 

used to adjust the normalized scatter of the residuals to be near unity. However, 

both display of “cross” offsets and use of “cross” coordinate formal error constants 

is recommended. In the former case, it makes the residuals for the first axis easier 

to evaluate visually. In the latter case, it represents unmodeled errors for the first 

axis as a noise level in the precision of the offset determination rather than the 

precision of the encoder read-out. 

  

7.6 Viewing individual sources 

 

Individual sources can be highlighted by selecting them from the Source menu 

item. This is useful for identifying which points go with which sources and to see 

if there is any source specific systematic behavior. 

  

7.7 Viewing the raw data 

 

When testing to see if a new pointing model is needed, it is useful as a first step to 

examine the raw data. You can select to view the raw data from the Data main 

menu. The choices on the menu are raw data and residuals. If you select 

raw data the plots and statistics (see next sub-section) will refer to the raw data 

rather than the default residuals to the latest solution. 
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7.8 Statistics 

 

The number points used and available are shown in the lower right of the display 

in the format used/available. 

 

The average and RMS scatter of the residuals (or raw data) for both axes can be 

shown by selecting the Statistics menu item. If the average error for the 

residuals on either axis isn’t zero when the residuals are displayed, something is 

wrong. e.g., an offset parameter may not be selected for that axis. The average may 

be non-zero for raw data. The RMS residual scatters for a good solution would 

typically be 10% or less of the full-width half-maximum power (FWHM) 

beamwidth. 

 

7.9 Editing data 

 

Strictly speaking data should never be edited. However, in the words of a teacher I 

once had “real data is nasty stuff”. In other words, it has all sorts of “blunders” and 

errors that make some points simply invalid and distort the results. The problem is 

that strictly speaking without a priori knowledge there is no way to tell for sure 

which points are blunder points and which are really telling you that there is 

something wrong with your pointing model form. Fortunately, with pointing data, 

simple models are usually enough. Editing does however need to be done 

conservatively to be safe. 

 
7.9.1 Three-Sigma editing 

 

One of the more defensible forms of editing when there are a lot of data is to apply 

is an “X-sigma” criteria, “X” is usually “three”. In other words, if a residual differs 

from zero by more than three times its sigma, it should be removed. For well 

distributed data, typically 1% are removed under a three-sigma criterion. The Edit 

menu item has a x-sigma option to apply such a criterion uniformly to all the data 

on both axes. Afterwards, the data should be reprocessed by selecting the 

Reprocess option on the Edit menu item. It may be necessary to iterate the X-

sigma editing and reprocessing several times before only a few or (hopefully) no 

more points are removed. This process will fail if the residuals do not have a 

Gaussian distribution, because in most such cases the editing will progressively 

remove more data on each step until there are no data left. If that happens or a 

significant fraction of the data is removed, you need to investigate why the residuals 

do not have a Gaussian distribution. If possible this should be corrected, perhaps 

by changing the model. If it can’t be corrected, you will need to stop editing after 

one or two iterations and hope for the best. 
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7.9.2 “Point and shoot” manual editing 

 

A somewhat less defensible approach is to manually delete any points with 

residuals that differ significantly from zero relative to their error bars. This is a 

somewhat artistic process. It is needed sometimes to remove big outliers either 

because there aren’t enough data to apply a three-sigma criterion or some other 

reason. Since the plot limits include the extent of error bars on points it is sometimes 

helpful to delete all points that have unusually large error bars. These points usually 

do not contribute anything significant to the solution. If their error bars are very 

large compared to the error bars for the bulk of points it is likely that they are 

blunder points anyway. However, you have to be careful, for example, if you are 

viewing azimuth offsets (instead of xEL offsets), points with large error bars at high 

elevations may be legitimate and significant. 

 

To add or remove a point manually, place the pointer on or near it and click on it. 

The point selection is slightly “sloppy” because it was found to be hard to use 

otherwise. You can also adjust the plot axes to make it easier to distinguish points 

that are close together. After editing out or adding back in points, be sure to 

reprocess the data using the Reprocess option on the Edit menu item. There is 

also an Add all points option on the Edit menu item to return all points to 

the solution.  

 
7.10 Sigmas 

 

Three types of sigmas are available for use or display in pdplt. The default sigma, 

the a priori, is the most useful and is the only one that is normally needed. (You 

can stop reading this paragraph at this point and skip to the next sub-section unless 

you want to know more about this.) This value combines the effect of the raw 

observed sigma with the added noise for each axis that had to be applied to make 

the reduced χ
2

 of the solution come out close to unity. This provides in some sense 

the best available estimate of the true sigmas of the input data. The other types are: 

(1) “input”, which is just the raw observation sigma and doesn’t include the added 

noise contribution, this is mostly a curiosity and (2) “a posteriori” which is the 

sigma of the residuals after the solution, rather than of the input data. Ideally the a 
posteriori sigma should be used for all editing operations, but in practice this is a 

subtle distinction. For pointing data, except in situations with very sparse data, it is 

usually the same as the a priori sigma. If the data are sparse enough that there is a 

significant difference between the a priori and a posteriori sigma, then there may 

not be enough data to make a good solution anyway. Consequently, the a posteriori 
sigma is mostly a curiosity as well, but in some cases it may be useful. 

 

7.10 Printing plots 

 

Plots can be printed individually either directly to the printer or to a file. The output 

is PostScript. Select the Print option from the File menu option. 
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7.11 Saving the results 

 

The results can be saved using the Save option from the File menu. The data, 

including any editing, is typically saved to a file with a name of the form 

xtrYYYY.DDD in /usr2/log/, where YYYY.DDD is the last digits of the year 

and day of the year. The date is taken from the log the data were extracted from. 

This file is the format of an xtrac program output file and can be read into pdplt 

again using the Open option in the File menu option. The results of the analysis 

are saved in a file of errYYYY.DDD.  This file is in the format of an error 

program output file. This file is used by in updating model step described below. 

The options for saving the data can be modified using the I/O Setup option from 

the File menu item. 

 

7.12 Update the model with update YYYY.DDD and restart the FS 

 

Once the analysis has been finalized and the results saved as described above, the 

model can be updated. Issue the command update YYYY.DDD while in a shell, 

where YYYY.DDD is suffix of the errYYYY.DDD file created when the results 

were saved. The suffix doesn’t necessarily have to be in the format of YYYY.DDD 

as long as it is specified as the argument for update and agrees with the actual 

suffix to err in the file name. The update program will comment out the active 

model in mdlpo.ctl and append the new one. To begin using the new model, 

stop the FS and restart it (or do whatever is necessary to have the model read in if 

your antcn doesn’t read it automatically at start-up, maybe you need to enter it by 

hand into your pointing computer).  You should always do at least a quick pointing 

check to make sure that the new model is good before using it for an experiment. 

 

7.13 Changing model parameters 

 

If during the analysis of the data, any unmodeled systematics are discovered, it is 

possible to modify the form of the model to remove them. The default model has 

several parameters beyond the basic eight. These can be turned on and off in the 

analysis by using the Modify Parameters item in the Edit main menu. There 

is a Parameter Explanation page to help identify the parameters. After 

making any changes, it is necessary to select Reprocess on the Edit main menu 

to see the results. Please note that making changes here does not permanently 

change the values used in the mdlpo.ctl file. It only changes parameters used 

for the current analysis session with pdplt. However, if you change the parameter 

settings, save the results of an analysis with them, and then update the mdlpo.ctl 

file, the new model in the mdlpo.ctl file will use the new parameter 

configuration. This behavior is automatic and is generally the most useful. For more 

information on the flags and their values and the parameters that are available, see 

the Pointing Model File manual (ACP Files) in Vol. 2 of the FS manuals. If the 
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parameters that are available are not sufficient, they can be expanded, please 

contact Ed (Ed.Himwich@nasa.gov) for more information. 
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